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Qslip - User Guide - First Run of Qslip

1.  Qslip attempts to locate the folder to which the QuickBooks file save dialog defaults, which varies depending on 
version. If you do not have QuickBooks installed, or it is version 5 or earlier and not located on your C: drive, you will 
receive a prompt to select the drive on which it is installed. Click "Cancel" if you do not intend to import from 
QuickBooks, or if you would like to try some sample files first. 

2.  If QuickBooks is found, the Qslip open file dialog for importing files will open to this location the first time (step 3 
below). This is for convenience only - you can always navigate to this or any other folder. 

3.  The 60-day trial period is commenced. 
4.  If you have purchased a license for Qslip, select "License Qslip" from the "Help" menu to enter your License Name 

and Key. After the trial period expires, Qslip will still function normally, but printed output will be partially obscured by 
a watermark. Entering a valid Qslip license will remove the watermark. 

5.  Qslip prompts for a file to open. 
6.  If you have already exported a deposit file from a supported accounting application such as QuickBooks, you may 

open it. Otherwise, you can open a sample from the "..\Qslip1\Samples" folder, or select "New" from the "File" menu 
(or click the "New" button) and create a new deposit. 

7.  Qslip opens ready to use:



 
8.  Set the layout options for your deposit slip format. 
9.  Set layout positions. 
10.  Test printing on deposit slips. 
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Qslip - User Guide - Setting Layout Options
 

1. Set the fields you want printed on your deposit slips under 
"Print on Slip." 

2. Choose the fonts. The amount font must be a TrueType, 
fixed-width font in order to print properly.

3. Set the font sizes (in points) that best fit your deposit slip 
format.

 



If the deposit slip is set as 2-sided, there will be additional 
items to set.

 

4. Set the character spacing for amounts. This is primarily 
used to align digits with the pre-printed boxes or columns on 
some deposit slip formats. (0 is default spacing, 100 is twice 
normal, 200 is 3 times normal, and so on). 

(enabling Decimal Point and/or Thousands Separator will 
disable extra character spacing.) 

5. Select the printer you wish to print your deposit slips.

6. Set the overall Horizontal and Vertical alignment. This will 
move the entire deposit info image left-right, up-down. This 
also lets you leave your printer set to standard 8.5" x 11" 
paper. 



This setting is very important when you want to position your 
deposit slip image on your pre-printed slip. It moves all the 
fields equally. 

 

If the deposit slip is set as 2-sided, the Side 2 character 
spacing and Alignment controls will be enabled.



 

Next step is to set the printing positions.
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Qslip - User Guide - Set Layout Positions

Grab a ruler and a blank pre-printed deposit slip 
●     For best results, make all measurements to the nearest 32nd of an inch.
●     Skip any items not used on your slip format (eg. Checks Total) -- they will appear grayed-out.
●     You may enter decimal or fractional amounts in the measurement edit controls (decimals will be converted to 

the nearest fraction).

 

Layout: 

1. Set the value for "Number of Checks" to the exact number 
of check lines on the front of the deposit slip. 

2. Measure the overall width and height of the slip, and enter 
values in "Slip Width" and "Height."

3. Measuring from the left edge of the slip, to the points 
marked in blue, enter the corresponding values.

4. Measuring from the top edge of the slip, to the points 
marked in red, enter the corresponding values.

 



Add'l Layout: 

5. Measuring from the left edge of the slip, to the points 
marked in blue, enter the corresponding values. 

6. Measuring from the top edge of the slip, to the points 
marked in red, enter the corresponding values.

 

If the format is 2-sided:



7. Set the value for "Max Checks" to the exact number of 
check lines on the back of the deposit slip. 

8. Measuring from the left edge of the slip, to the points 
marked in blue, enter the corresponding values.

9. Measuring from the top edge of the slip, to the points 
marked in red, enter the corresponding values.

 

If the format is Multi-Columned:



Follow the special instructions. This feature is primarily 
included in order to print to the QB native format, however it 
can be used to print to other multi-columned slips.
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Qslip - User Guide - Printing on Deposit Slips

1.  Place a blank pre-printed deposit slip in the envelope bypass or any adjustable tray of your printer and adjust 
the guides to fit your slip.

2.  Click "Print" in Qslip.
3.  If it is a 2-sided deposit slip, Qslip will prompt you to reinsert the deposit slip in order to print the back.

(optional) Click "Preview" to see the deposit information as it 
will be printed. Text in red on the preview does not print on 
the slip -- it's just for reference.
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Qslip - User Guide - Importing
1.  Importing from QuickBooks (all versions)
2.  Importing from other applications
3.  Optimizing the import process (includes command-line parameters)
4.  Import errors
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Qslip - User Guide - Importing from QuickBooks
Prior to exporting from QuickBooks

1. (optional) When receiving checks, enter the Bank Number 
from the checks in the memo field in the "Receive 
Payments" or "Cash Sales" windows. 

Qslip will read this from the QB export file. 

If you have the customer list feature enabled in Qslip, you 
can skip entering the bank number here if the customer (and 
bank number) are in Qslip's customer list. 

A stay-on-top customer list viewer (QSviewer) is included 
with Qslip. It can be handy to keep it open while entering 
payments received in QBooks -- a quick glance will let you 
know whether you can skip entering the bank number for a 
customer.

 

2. (optional) If you have other info that you wish to place in the memo 
field, place it after the Bank Number, separated by a comma. 

Qslip will read the Bank Number from the QB export file, placing the text 
after the comma into Qslip's Memo field. 

If you are not entering a bank number, place a comma before any 
memo text you wish to enter.

 

3. If you need to assign a single check to more than one payment received transaction, preface the Check Number with a "p" character 
(eg. p23081) each time it is entered. Qslip will combine the separate transactions into one check item for the deposit.



 

Export from QuickBooks

 

1. At the "Make Deposit" window, after selecting items for 
deposit, click the "Print" button.

 

2. In QB99 and above, select "Deposit summary only" when this dialog 
appears.

 



3. In the next window, select the "File" radio-button, and 
ensure "Tab delimited file" is the selection next to it. 

You can use the "ASCII text file" type, but field information 
may be truncated.

4. Click "Print."

 

5. Type a name for the file to create, or select one from the 
list of files. If you always use the same name (eg. deposit.
txt), Qslip will load it on startup, saving you the extra step of 
loading it into Qslip. 

6. Click "Save." (if you select a file from the list, you will 
receive a prompt asking if you want to overwrite the file - 
choose yes).

note: QuickBooks99 and prior always default to the 
QuickBooks program folder for this dialog.

 

7. The ASCII file has now been created, and you can run Qslip immediately (or later).



 

Import to Qslip

 

1. Run Qslip. If this is the first time, you will get an open file 
dialog. Open the file you exported from QuickBooks. 

Subsequently, when you run Qslip, it will open the last file 
you had open before exiting, skipping this step.

You can also open a file at any time while Qslip is running.

 



2. The selected file (or last viewed file) is loaded into Qslip. If 
this is not the file you exported from QuickBooks, select 

"Open" from the "File" menu or click the  and use the 

dialog to open the file you exported. 

Any discrepancies in the import file will be displayed in a 
warning dialog.

The import stage is complete. Now you can get ready to 
print a deposit slip.

The QuickBooks Bank Account and Deposit Total are shown 
for reference.

3. (optional) You may change the date.

4. Set the currency and coin amounts. Editing one will 
change the other, so that currency + coin = cash total.

The slip format is displayed at the bottom for reference. If 
this is not correct, select the proper format.

 

5. (optional) If you haven't entered some or all of the Bank or 
Check Numbers for the checks in QuickBooks, you can 
enter them now.



 

6. (optional) Click "Preview" to verify the deposit information 
as it will be printed. 

7. (first time only) Setup your deposit slip layout and adjust it 
for printing.

8. Place a blank pre-printed deposit slip in your printer. 
(details).

9. Click "Print."
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Qslip - User Guide - Importing from Other Applications
 

Qslip can also import deposit data from generic comma-separated (CSV) or tab-delimited (TAB) files. The headers and rules 
are the same for each, only the delimiter structure is different. CSV files must use double-quotes around fields that contain a 
comma character. TAB files do not require any quoting. In either case, field-enclosing quotes will be stripped. Headers and 
PmtMethod types are not case-sensitive. Order of columns is not important with one exception: the PmtMethod column must 
NOT be the last column.

A special PmtMethod type named ACCT lets you import the bank account name to which the deposit will be made, the deposit 
total and date. Put the name of the account in the DocNo column. Put the date for the deposit in the BankNo column (or leave 
blank for current date). Put the deposit total in the AMOUNT column to cause Qslip to compare its internally calculated total to 
this amount (leave blank or zero to skip). Only one row of this type should be in the file, otherwise only first one will be used.

The following columns and headers are required (additional columns will be ignored): 

 

HEADER ACCEPTABLE DATA 

PmtMethod Must be one of CASH,COIN,CHECK,CASHBACK or ACCT 

DocNo Check number (eg. 12345) or account name for ACCT 

BankNo Bank number (eg. 16-49) or date (m/d/yy) for ACCT 

RcdFrom Customer name (or name of check issuer) 

Memo Any text 

Amount Amount in format 1234.00 or 1,234.00 or $1,234.00 

 



Sample CSV file

PmtMethod,DocNo,BankNo,RcdFrom,Memo,Amount
Cash,,,Tom Jones,,163.00
Coin,,,Larry David,,1.33
Check,1423,12-333,Tom Jones,"This is a memo with, comma",1478.39
Check,1638,16-49,Larry David,,"$10,989.27"
Check,19683,17-22,Ralph Anderson,,158.94
Cash,,,RLI Ltd,,13.44
Check,6958887,16-9837,SBF,,"9,528.21"
CashBack,,,,,100
Acct,Checking,12/31/02,,,22232.58 

 

Import to Qslip

 

1. Run Qslip. If this is the first time, you will get an open file 
dialog. Open the file you exported from your application. 

Subsequently, when you run Qslip, it will open the last file 
you had open before exiting, skipping this step.

You can also open a file at any time while Qslip is running.



 



2. The selected file (or last viewed file) is loaded into Qslip. If 
this is not the file you exported from your application, select 

"Open" from the "File" menu or click the  and use the 

dialog to open the file you exported. 

Any discrepancies in the import file will be displayed in a 
warning dialog.

The import stage is complete. Now you can get ready to 
print a deposit slip.

If you included an ACCT row in the file, The Bank Account 
and Deposit Total are shown for reference.

3. (optional) You may change the date.

4. Set the currency and coin amounts. Editing one will 
change the other, so that currency + coin = cash total.

The slip format is displayed at the bottom for reference. If 
this is not correct, select the proper format.

 

5. (optional) If some or all of the Bank or Check Numbers for 
the checks were not in the deposit data, you can enter them 
now.



 

6. (optional) Click "Preview" to verify the deposit information 
as it will be printed. 

7. (first time only) Setup your deposit slip layout and adjust it 
for printing.

8. Place a blank pre-printed deposit slip in your printer. 
(details).

9. Click "Print."
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Qslip - User Guide - Import Optimizing

1.  Enter Bank Numbers from checks in the memo field in QuickBooks. 
2.  Use the same filename each time you export a deposit. 
3.  Name the export file with a name that matches the Slip Format's "Filename that will have this format assigned."

Qslip will load the file on startup and all you will have to do is place a blank deposit slip in your printer, possibly 
edit the coin & currency amounts, click "Print" in Qslip - and you're done!

4.  Passing files on command line. Using this feature, a Windows shortcut can be created that will launch Qslip 
and load the file. Just add a shortcut to the Qslip executable including the filename to open (put a space 
between the 2 paths: ie. "C:\Program Files\Qtools\Qslip1\Qslip.exe C:\Data\Qbooks\Deposit.txt")

This is most useful if you regularly print to more than one deposit slip format. By using the appropriate 
"Filename that will have this format assigned" setting in Qslip when exporting the deposit, you can setup 
shortcuts to each deposit export file (be sure to create an export file before trying to create the shortcut).

4.  This feature can also be used to run Qslip from another application and automate its printing process 
using the switches. See Importing from other applications for information on generic import formats 
that can be passed to Qslip.

The Slip Format can be set using the second parameter. This overrides any Slip Format assignment 
based on the filename. This override lasts for the entire Qslip session, so you must close Qslip to clear 
this override setting. If this causes problems use the filename format assignment method instead.

 

Parameters:

1. Deposit data filename (full path required).

2. Deposit slip format name. (optional)

Switches: (must be after above file references. All are optional.)

-autoprint Sends loaded slip to printer.

-autoprintsilent Closes Qslip after printing, and suppresses most warning dialogs.



-nocustlist Disables Qslip customer list usage.

-copies=n Sets number of copies to print.

-printreport Prints deposit report instead of deposit slip.

Place quotes around any parameter that contains spaces.

Example:

"C:\Program Files\Qtools\Qslip1\Qslip.exe" "C:\Program Files\Qtools\Qslip1\Samples\depBD81.TXT" 
"Deluxe BD43" -autoprintsilent
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Qslip - User Guide - Import Errors
●     Qslip checks import files for errors and integrity, and warns of any findings.
●     If any of the User Actions does not solve your problem contact Qtools Support.

QuickBooks

ERROR Qslip Action User Action

Invalid (or corrupt) file format. file will not be imported. Export the deposit from QuickBooks again.

Any items not Cash or Check (eg. 
VISA, etc.).

file will be imported so that you can note 
problem item(s).

Correct the error in QuickBooks and export 
the deposit again.

Deposit total given by import file does 
not match actual total of items.

file will be imported so that you can note 
problem item(s).

Export the deposit again.

There are more checks in the import 
file then the number allowed in the 
Max Checks setting in Qslip

file will be imported so that you can change 
settings, or note error for correction in 
QuickBooks.

Increase the setting in Qslip if it is less than 
that maximum number of checks that will fit 
on your deposit slip. 
-or-

Edit the deposit in QuickBooks and reduce 
the number of checks, then export it again.
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Qslip - User Guide - User-Entered Deposit Slips
 

1. Select "New" from the "File" menu, or click the  

button. 

2. The Deposit Date is set to the current date - you may 
change this.

3. Set the Currency Total (paper money).

4. Set the Coin Total.

5. Enter Cash Back (optional).

6. Change the Slip Format (if necessary)

 



7. Enter checks. 

If the customer list feature is enabled, customer name and 
bank number will be auto-filled based on previous entries.

●     Use the TAB key to move across through fields.
●     Use the ENTER key to move down the items in a 

column. (In Preferences, you can set the ENTER key to 
act the same as TAB key.)

●     Pressing CTRL+INSERT will insert a blank row above 
the current row.

●     Pressing CTRL+DELETE will delete the current row.
●     Checkboxes above columns determine which columns 

are active when TABBING through fields to help speed 
data entry. 

 

8. Click "Preview" to verify the deposit information.

9. Print the deposit slip.
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Qslip - User Guide - Setting the Slip Format
 

Format Name : Select a format from the drop-down list. 

The "Filename that will have this format assigned" lets you 
assign the displayed format to import files using that name 
plus any extension (such as ".txt").

Any changes to the format settings on this tab page and the 
subsequent options and layout pages apply to the currently 
selected Slip Format, and are automatically saved before 
selecting another format, previewing, printing or closing 
Qslip.

To create a new slip format, enter a new name or click the 
"Create New Format" button, then...

 



To create a new slip format, starting with default values, 
enter a name for the new slip and click "OK".

 

-OR-

To create a new format based on values from an existing 
format, select that option, enter a name for the new slip, 
select the format to copy and click "OK".



 

Then Setup your deposit slip layout and adjust it for printing.
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Qslip - User Guide - Setting Preferences
General Preferences

 

Customer List Preferences



 

QBooks Preferences

 



Security Preferences
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Qslip - User Guide - Slip Formats

1.  Setting, Creating & Editing Slip Formats 
 

Example: Setting up custom slip formats for 2 bank accounts and 2 printers, and assigning them to import 
filenames.

2.  Setting layout options
3.  Setting layout positions
4.  Testing layout and options settings
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Qslip - User Guide - Example

Let's say you have 2 bank accounts, one with Wells Fargo and the other with Bank One. The deposit slips are 
different. In addition, you want the option to use either of 2 printers.

1.  Click the "new" button on the "Slips" tab of Slip Format setting section to create a new slip format in Qslip to 
match the first bank account's pre-printed deposit slip, if it isn't among those included with Qslip, using the first 
printer. Name the slip format descriptively, such as "WellsFargo-HP5L".

2.  Enter a short, descriptive name in the "Filename that will have this format assigned" box, such as "depwf5l".
3.  Set the Layout Options and Positions.
4.  Once you have it printing properly, click the "new" button again, name the new slip format to identify that it will 

use a different printer, such as "WellsFargo-Epson6000"; choose the option to "Copy values from any existing 
format to a new one" and select the new slip format you created above; change the file assignment name to, 
for example, "depwfe6"; change the printer on the "Add'l Options" tab to the second printer; test the settings 
since you might need to adjust the side 1 and side 2 alignment.

5.  Repeat items 1 - 4 above for the second bank account, using "BankOne" in place of "WellsFargo" for the 
format names, and something like "depb1..." for the file assignment names.

You now have 4 custom slip formats that can be assigned to import files, simply by naming the file appropriately 
(e.g. depwf5l.txt) during export from the accounting applications such as QuickBooks. When you open the file in 
Qslip, the correct slip format (and printing device) will be assigned.

Remember, you can always print the current deposit info with any available slip format by selecting it from the 
drop down list on the "Slips" tab of the "Slip Format" section.
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Qslip - User Guide - Testing Layout & Options Settings

Test the individual field positions 
1.  Print a deposit slip (either a sample included with Qslip, or a deposit of your own) to standard 8.5" x 11" paper.
2.  Place a blank pre-printed deposit slip over the standard sheet.
3.  Hold up to the light, align the date field, and note positions of other items.
4.  Make adjustments to field positions values as necessary and retest.

Test the overall alignment

1.  Once the individual field positions are aligned, fold the standard sheet vertically in half.
2.  Fold the blank pre-printed deposit slip in half vertically.
3.  Place the slip over the standard sheet, aligning the folds and the top edges.
4.  Hold up to the light and note positions.
5.  Make adjustments to the Vertical and Horizontal alignment values as necessary and retest.

Print a test to a blank pre-printed deposit slip

1.  Check alignment and adjust as necessary.
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Qslip - User Guide - Saving Deposit Info to File

Saving a deposit slip in Qslip saves it to a Qslip formatted file which can be loaded back into Qslip. This allows 
you to save any changes you have made to a deposit. 

●     "Save" will save without prompting (unless the deposit is new and unnamed) to the current filename and 
location.

●     "Save As..." will allow you to name the file and set its location.
●     When the file is re-opened, any editing restrictions will still be in effect depending on whether the deposit was 

an import from an accounting application, or created in Qslip.
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Qslip - User Guide - Customer List Feature
The purpose of the customer list feature is to speed data 
entry. It is automatically maintained by Qslip, so you 
shouldn't need to worry about it. However, the tab page 
shown here allows you to edit and purge the list if you 
choose, as well as import from an external list. 

You can disable this feature in preferences.
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Qslip - User Guide - Known Problems & Workarounds
1.  Under Windows NT, 2000 & XP, Qslip must be installed by a user with administrator rights. Windows Vista will request and requires 

elevation to administrator rights for installation. After installation, Qslip can be run with standard user rights. 
2.  Under Windows NT, in order for the spacing between characters to print properly, the following change must be made to the printer 

properties: 
3.  Open the Printers dialog in Control Panel. Right click on the desired printer icon. Choose "Properties" from the menu. Click the "Print 

Processor..." button. Select "RAW" as the Default Datatype and check the box next to "Always spool RAW datatype." Making this 
change will not adversly affect printing for other applications, and may solve other printing anomolies. 

4.  Multiple users attempting to run the Qslip application from a network drive will receive a "Hardware has changed - please re-enter 
your registration key" message. Although Qslip works fine in a network environment, and can access files anywhere on the network, 
the application itself must be installed on each workstation that will run it. 
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Qslip - User Guide - Printers List & Fixes

Most printers that work with Windows should work fine with Qslip. This list is meant to aid trouble-shooting.

Printers Known to Work with Qslip

1.  Canon BJC-7000, BJC-5000, i9900
2.  Epson ActionLaser
3.  Epson EPL-6000
4.  HP 5L series
5.  HP 6L series
6.  HP 820C series
7.  HP 4000 series
8.  Lexmark Color Jetprinter 1020
9.  Lexmark E210 

Printers that have problems outputing from Qslip

1.  HP 722c - bypass tray feed problem reported by some users (use main tray)
2.  HP 895cse - bypass tray feed problem reported by some users (use main tray)
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Qslip - User Guide - Command-Line Parameters

Passing files on command line. Using this feature, a Windows shortcut can be created that will launch Qslip and 
load the file. Just add a shortcut to the Qslip executable including the filename to open (put a space between the 2 
paths: ie. "C:\Program Files\Qtools\Qslip1\Qslip.exe C:\Data\Qbooks\Deposit.txt")

This is most useful if you regularly print to more than one deposit slip format. By using the appropriate "Filename 
that will have this format assigned" setting in Qslip when exporting the deposit, you can setup shortcuts to each 
deposit export file (be sure to create an export file before trying to create the shortcut).
This feature can also be used to run Qslip from another application and automate its printing process 
using the switches. See Importing from other applications for information on generic import formats that 
can be passed to Qslip.

The Slip Format can be set using the second parameter. This overrides any Slip Format assignment 
based on the filename. This override lasts for the entire Qslip session, so you must close Qslip to clear 
this override setting. If this causes problems use the filename format assignment method instead.

 

Parameters:

1. Deposit data filename (full path required).

2. Deposit slip format name. (optional)

Switches: (must be after above file references. All are optional.)

-autoprint Sends loaded slip to printer.

-autoprintsilent Closes Qslip after printing, and suppresses most warning dialogs.

-nocustlist Disables Qslip customer list usage.

-copies=n Sets number of copies to print.

-printreport Prints deposit report instead of deposit slip.

Place quotes around any parameter that contains spaces.

Example:



"C:\Program Files\Qtools\Qslip1\Qslip.exe" "C:\Program Files\Qtools\Qslip1\Samples\depBD81.TXT" 
"Deluxe BD43" -autoprintsilent 

Copyright Qtools Software - © all rights reserved

QuickBooks & QuickPayroll are registered trademarks of Intuit, Inc.



*** REVISION HISTORY for Qslip ***

v2.00 (1/8/07):
        -Changes to support Windows Vista (which also improve security
on Windows XP and Windows 2000).
        -New Feature: Dynamic preview of changes to deposit information
and slip format settings. Preview displays at startup if it was open at
previous Qslip exit.
        -New Feature: Checks and Customer Lists can now be sorted by
clicking on column header.
        -New Feature: Tech Support Info Tool on Help menu. Collects
application and system information to email to Qtools support to aid
in troubleshooting.
        -New Feature: Detection and warning if a second instance of
Qslip is started. If you run concurrent instances of Qslip, deposit
slip formats and customer list data will be overwritten by each
instance. Changes made in one instance will be lost if the other
instance is closed after it.
        -If the Windows DPI is changed, such as setting to use Large
Fonts, Qslip windows now size correctly.
        -Many small interface fixes and improvements.
        -Bugfix: The first time some dialogs appeared (New Slip Format,
Preferences, etc.) they could be out of view at smaller screen
resolutions, which would make Qslip appear to lock-up. These dialogs
are now always centered on Qslip window.
        -Printed output is now partially obscured if trial period has
expired and a valid license key has not been purchased and entered.
        -Files that store slip formats (slips.dat), customer list
(custlist.dat), and license information (Qslip.qlic) are now located
in the common application data folders available to all users. These
files should be backed up regularly.
On Windows versions prior to Vista (XP, 2000, etc.):



\Documents and Settings\All Users\Application Data\Qtools\Qslip2
On Windows Vista:
\ProgramData\Qtools\Qslip2

v1.60 (9/12/06):
        -Bugfix: Printing was failing with error message "Divide by Zero"
when printing to some printers when certain other printers are set as the
Windows default printer. 

v1.59 (8/1/06):
        -Bugfix: Save As dialog was not recalling last saved folder. 

v1.58 (6/12/06):
        -New feature: Utility to convert deposit files saved in Qslip to
comma-separated format. Allows selection of multiple files to combine.
Creates 2 files -- a detailed transaction file, and a summary by customer.
Located on the Utilities sub-menu of the File menu.

v1.57 (3/18/06):
        -Bugfix: Bank Account name was not being saved or read correctly
for deposits created in Qslip (imported deposit files not affected).

v1.56 (10/12/05):
        -New feature: Option to print deposit item line numbers on
report. (see preferences)
        -Bugfix: Allow blank BankNo entry - now entering a space
character will prevent auto-fill of customer's bankno from customer
list.

v1.55a (8/19/05):
        -Bugfix: Manual checks entry was limited to number of visible
lines in data entry window (v1.55 only).



v1.55 (8/15/05):
        -New feature: Option to disable column(s) to speed check entry.
        -New feature: Option in preferences to use [ENTER] key to tab
through fields when entering checks.
        -New: For users not importing data, when Qslip is first started
it now recalls the last Slip Format used in previous session.
        -Bugfix: Fixed issues in dropdown boxes which first appeared
in version 1.50.
        -Bugfix: Fixed Generic CSV import errors if first or last column blank.

v1.51 (4/21/04):
        -New feature: Option to itemize cash line items on deposit report
for imported deposits. (see Preferences).

v1.50 (3/6/04):
        -Minor updates to better handle folder searching for
recent QB versions.
        -Updated installer for better WinXP compatibility.
        -After installation and first run by a user with Power
User or Admin rights, can now be run by users with "User" group rights.

v1.40 (12/12/03):
        -New feature: Generic CSV and TAB import formats added.
        -New feature: Add additional command line capabilities
to set Slip Format, automatically print, etc.
        -Bugfix: Currency, Coin and Cash Back edit controls
gave floating point error on entry if displaying a thousands
separator.
        -New: Deposit Report font size for header and items
can be set independently.

v1.33 (1/12/03):



        -Handle change in deposit file format for QB 2003.
        -Made Bank Account name editable.
        -Store customer names even if Bank No. is blank.

v1.30 (2/28/01):
        -New Feature: Add Depositor Info to printing
options - Name and Address, Account#, Bank and Address,
custom Other Text.
        -New Feature: Preferences option to remove split
check identifier "p" from check numbers on QB import.
Default setting is OFF.
        -New Feature: Preferences option of whether to
combine split checks. Default is ON.

v1.20 (6/21/00):
        -New Feature. Support added for QuickBooks native
deposit slip format.
        -New Feature. Multi-column deposit slip support.
        -New Feature. Printable deposit report.
        -New Feature. Cash Back amount is now printed
on deposit slip.
        -New Feature. Qslip maintained customer list
to speed data entry: recalls bank numbers on imported
deposits, and performs auto-fill of customer name and
bank number on user-entered deposits.

v1.18 (3/6/00):
        -Bugfix. Occasional Access Violation error when
closing Preferences dialog.
        -Bugfix. "Duplicate File Load Name not allowed"
error sometimes inaccurate.
        -New Feature. Stronger validation of "slips.dat"
file and data.



v1.17b (1/8/00):
        -Bugfix. Removed bug-checking code left from
trouble shooting previous bug.

v1.17a (1/8/00):
        -Bugfix. In rare cases an "invalid floating point
operation" error would abort printing or previewing a
deposit slip. This only affected v1.17.

v1.17 (12/8/99):
        -New Feature. Any combination of Customer Name,
Memo, Bank # and/or Check # can be printed on the slip.
        -New Feature. Filename can be passed to Qslip
on command line.
        -Bugfix. Y2K error if a pre-2000 deposit slip
opened on or after 1/1/2000.
        -New Feature. Allow Max Checks to be set to zero
to enable printing on back of deposit slip only.
        -Bugfix. Crashed if system had no default printer.

v1.16 (2/22/99):
        -Bugfix. The security setting in preferences
"delete last import file on exit" will now only delete
valid files that Qslip can open. Before the fix,
whatever file that was last attempted to be opened
using the Qslip File Open dialog would be deleted
on exit (if the preference was enabled by user; the
default setting is disabled).
        -New Feature. Utilities menu item to set File
Open dialog to samples folder.
        -New Feature. Cash Back editable on user-created
deposit slips, plus option in preferences to disable or



enable this feature.
        -New Feature. Option in preferences to start
with a new blank deposit on startup, or open last viewed
deposit file.

v1.15 (1/1/99):
        -New Feature. QB99 support added. Accomodates
both 2 and 4 digit years in the deposit date field,
and handles the new Cash Back option.
        -New Feature. Support added for tab-delimited
QuickBooks export files.

v1.14 (10/27/98):
        -Bugfix. Import files with no check number
values could fail with an "Access Violation..." error.

v1.13 (10/15/98):
        -Bugfix. Cancelling the "New Format" dialog
was changing the current format to the first one in list.
        -New feature. The "slips.dat" file, which stores
the slip formats, is now not overwritten when doing an
upgrade over a current install. Instead, a file called
"newslips.dat" is placed in the program directory. The
first time Qslip is run, this file is merged with any
existing "slips.dat" file, and any formats with same
name are not merged. This allows users to upgrade without
losing any new or modified slip formats, and also will
allow additional slip formats to be released and
installed separately.
        -New feature. An option to print Check Numbers
instead of Bank Numbers on the deposit slip.

v1.12 (8/29/98):



        -Bugfixes.

v1.11 (8/25/98):
        -Bugfixes and new features.

v1.01 (7/23/98):
        -First release.
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